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To activate, you must have a valid In-Tools account, and you will need to log
in from the Dashboard:

Emall: | sales@In-tools.com Password: Fok ko kK

Login Automatically Remember Login

We recommend keeping both the “Login Automatically” and the “Remem-

ber Login” check-boxes checked. This will ensure you are always logged in
when the dialog is opened (assuming you have an internet connection). If
you try to log in with an email account which is not registered, you will be

given the option to create a new account.

You also must have purchased a license of the plugin to activate it. If you

have not yet purchased a license, you can do so using the “Buy” button:

Euy

For further questions and issues regarding licensing and activation, please

refer to the FAQ web page; or for more help, please visit our forum.
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Introduction

Plug-in Versions
Wold Tools CSS comes in two version: a basic version, as well as World Tools

Pro. The difference between the two versions are as follows:

World Tools (Basic) contains features which are necessary for right-to-left
layout, including all the necessary menu commands, style, and find/change
integration, as well as a dedicated World Tools (ME) panel which gives con-

trol of all the necessary features ME related features is a single inteface.

World Tools Pro has all the features of World Tools Basic plus access to fea-
tures used by Chinese Japanese and Korean (CJK) languages. Additionally,
World Tools Pro contains a Composite Font Editor, which can create and
edit “composite fonts” which use different fonts installed in your system de-
pendent on the specific unicode range of your text. There are Kanji, Kana,
Roman, Number, punctuation, straight quote, Hebrew, and Arbaic ranges.
Composite Fonts are exceptionally useful when composing mulitlingual

text in a single paragraph.

ME Options

Directional Settings
There are many different levels of directional controls when dealing with

right-to-left text. Below is an overview of what each type of control does.

1. Document Direction: Controls the binding direction (i.e. which way
the book opens). When a book lays with the front cover up, a left bound
(Roman) document has the spine on the left side, while a right-bound docu-

ment has the spine on the right. Right binding is used for right to left lan-
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guages such as Hebrew and Arabic, as well as Japanese books which are set

in a vertical orientation.

2. Story Direction: Controls which way the columns flow in a multicol-
umn text frame. The story direction is controlled in the ME version by us-
ing the ME text frame tool when creating the story, or changing the story
direction in the story panel. In World Tools, it’s controlled by using the Story

Direction menu items or the World Tools panel.

3. Table Direction: Controls the column direction within tables. In the
ME version, it’s controlled by a button on the tables panel, in World Tools, it’s
controlled by the Table direction menu options or the World Tools panel.

Please note: There is no option for setting the table direction in table styles.

Table direction must be set manually for each table.

4. Paragraph Direction: Do not confuse this with paragraph alignment.
The paragraph direction controls the overall direction of a paragraph. For
example: if you type an English word and then a Hebrew/Arabic word fol-
lowed by a period, if the paragraph direction is left to right the English word
will be on the left, the Hebrew/Arabic word will be to the right of that, while
the period will be all the way on the right. If the paragraph direction is right
to left, the direction will be reversed with the English word on the right, the
Hebrew/Arabic word to the left of that, with the period all the way on the
left. If there is not a mix of directions within the paragraph (i.e. all English
text), the only effect of paragraph direction will be on the punctuation at the
end and the position of drop caps/numbering/bullets.

nnmp There is a difference in behavior between the ME version and
World Tools. In the ME version, when you change the paragraph

direction, the paragraph alignment is automatically reversed
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as well. We have found this behavior annoying (we think the
alignment should be kept as it’s defined!) so we changed it in
World Tools The alignment can be manually set to whatever you

want.

S. Character Direction: This controls the direction of characters. “Word”
will come out “droW” when set to right to left. “Default” determines the di-
rection based on the writing script. When set to “Default” neutral characters

(like punctuation) are determined by the surrounding characters.

6. Keyboard Direction: In CS2 version 4.0.2, Winsoft introduced “Key-
board Direction”. The idea sound nice at first, but one which we believe is ill
conceived. Basically Keyboard direction does the same thing as Character
Direction (although character direction trumps keyboard direction when
there’s a conflict). The difference is that keyboard direction can be set au-
tomatically while typing. There’s an option to have the keyboard direction
on neutral characters inferred by the keyboard layout used when typing. If
a right to left keyboard layout is used, the keyboard direction is set to right
to left and vice versa. The problem is (besides the double functionality) that
people don’t always use the correct keyboard layout while typing. When
switching between languages, it’s very common to not switch keyboard lay-
out until starting to type. The neutral characters then have their direction
set by the user. The real problem is directional neutral characters (like pa-
renthesis, brackets, etc.) The appearance of the characters are affected by
their direction. For example: (parenthetical statement) will be encoded
<0028>parenthetical statement<0029> if the parenthesis are right to left
and <0029>parenthetical statement<0028> if the parenthesis are left to
right. This really gets messy once you start doing search and replaces, etc.
Things get really messed up and the user has no idea why...
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To make matters worse, the keyboard direction settings do not show up as
style overrides so there’s no indication that they are applied unless you go

and check the keyboard direction menu listing...

We have not included the ability to set keyboard direction because we are
opposed to its existence. We strongly advise anyone receiving files from an
outside source to use the “Remove Keyboard Direction Overrides” com-
mand to ensure there are no keyboard direction settings anywhere in the

document.

World-Ready Composer

As stated above, InDesign’s World-Ready composer creates the ability to
properly compose right-to-left text and all related features. It is our under-
standing that the World-Ready composer is based on Winsoft's ME code
base, so for the most part, the functionality should be similar to the ME
version. Any features relating to text composition which are available in the
ME version, but have not been available in the Roman version, will only
be properly composed if the World-Ready Composer is enabled. Any bugs
which might be related to the World-Ready Composer will also only be an
issue if the World-Ready composer is enabled for specific text. Some exam-
ples of features which are only available with the World-Ready Composer

are: localized digits, diacritic positioning, Hebrew / Arabic numbering, etc.

Japanese Composer
World Tools does not provide user interface support the Japanese Compos-
er. If you need to compose Chinese Japanese or Korean, we recommend that

you purchase World Tools Pro.



Working with World-Ready Documents /

Working with World-Ready Documents

There will be three instances where you would be working with a World-
Ready document. 1) You are working on an existing ME document (created
in the ME version). 2) You are creating a new document which will have
right-to-left text. 3) You are editing an existing Roman or CJK Document,
and would like to add right-to-left text to the existing document.

Existing ME Documents

Existing ME documents will open correctly in any version of InDesign. You
do not even need World Tools for this. The World-Ready Composer will be
enabled by default and you can even make minor edits to the ME text. For
any edits which require control over ME features, though, you would need
either World Tools or the ME version of InDesign.

Existing Documents

To add ME or Indic text to an existing Roman or CJK document, you must
enable the World-Ready Composer. For Roman Documents, you can sim-
ply select “Enable World Ready Composition”. This will change any instance
of the regular Paragraph Composer or Single-line Composer to the corre-
sponding World-Ready Composer. For CJK documents, selecting this op-
tion will not have an effect on text that has the Japanese composer applied.
Instead you must select the World-Ready Composer for the appropriate
paragraphs or Paragraph Styles.

New Documents
By default, new documents in InDesign do not have the World-Ready Com-
poser enabled. To enable the World-Ready Composer, you can simply cre-

ate a new document and select the World-Ready Composer instead of the
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regular composer. There is also “Enable World-Ready Composition” in the
menu options which enables the World-Ready Composer for all text and
paragraph styles in the document. A document which was World-Ready en-
abled by World Tools is identical to a document which was created in the

ME version of InDesign.

Binding Direction

Binding Direction refers to the side of the pages on which a book is bound.
Books are either right bound or left bound. Books which are primarily writ-
ten in left-to-right languages are left bound, while books which are primar-
ily written in right-to-left languages (Hebrew or Arabic) are right bound.
The other type of book which is right bound is vertical Japanese. Japanese
books which are set horizontally are left bound, while ones set vertically are

right bound.

Binding direction can be set using the menu item: InTools >World Tools
Document > Right Bound/Left Bound Document. The binding direction
can also be set using the World Tools panel (see page 20).

Character Settings

OpenType Settings

There are a number of OpenType settings not normally available in the Ro-
man version of InDesign. World Tools makes these settings available under
the Character menu. The OpenType features require a font which supports
them. The additional features available are as follows: 1) Historical Forms:
These are special forms of letters which are generally somewhat archaic.
2) Justification Alternates: These are special stretched forms of glyphs which
are generally used to better justify text. These are the forms used by “Naskh
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Justification”. 3) Localized Forms: There are different forms of glyphs in
some languages. This feature applies the localized form. 4) Mark Position-
ing: Presumably this applies mark positioning programmed using the “mark”
OpenType feature. In our tests, we have not seen any effect by changing this
setting. We recommend using the Diacritic Positioning settings instead.
S) Overlap Swash: This enables swashes to overlap the following glyph pre-
venting unsightly spacing. This is commonly used in Arabic. 6) Stretched
Alternate: Enables the stretched forms of glyphs. 7) Stylistic Alternate: Uses
the glyph form programmed with the “salt” OpenType feature.

Kashidas
This option enables the use of kashidas in Arabic fonts. Kashidas are ex-

tended elements of glyphs which are used when justifying Arabic text.

Digit Types

Different languages around the world use different digit formats. The most
commonly used format for digits is what we call Arabic digits (1,2,3, etc.).
The World-Ready Composer supports 18 different digit formats.

Diacritic Positioning

(8] Diacritic Positioning...

Diacritic Position | OpenType I—:]

Horizontal 0 Vertical 0

The Diacritic Positioning dialog is a non-modal dialog which controls the
position of diacritic marks. For automatic OpenType positioning of marks,
select “OpenType” from the upper drop-down list. If you are using an old-
er non-OpenType font, you can select any one of the other options. The

» «

“Loose”, “Medium” and “Tight” settings affect the vertical placement of dia-
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critics in Arabic. In addition to the automatic placement, the diacritic can be
manually moved by editing the Horizontal and Vertical values. These values

are measured in 1/1000 em units.

Character Direction

Character direction controls which characters are considered right-to-left
and which ones are considered left-to-right. Under normal circumstances
Roman characters (as well as most writing scripts in the world) are left-to-
right. Arabicand Hebrew are the primary examples of scripts which are right-
to-left. When the character direction is set to “Default” InDesign tries to de-
termine automatically what the correct character direction is. For the most
part, this is simply a function of which Unicode range the glyph falls within.
Ifit’s in the Hebrew or Arabic range, it will be right-to-left, otherwise, it will
be left-to-right. For neutral characters (i.e. punctuation), InDesign uses an
algorithm to determine if they should be right-to-left or left-to-right. This is
based on the paragraph direction as well as the surrounding characters. Gen-
erally the Character Direction should be left with the default setting, unless

the default behavior puts neutral characters in the wrong place.

Keyboard Direction

In World Tools we did not include the ability to set keyboard direction. We
do not recommend its use, and we recommend removing all keyboard direc-
tion overrides on existing documents by selecting InTools >World Tools

- Character Direction >Remove Keyboard Direction Overrides.
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Paragraph Settings

Paragraph Direction

The paragraph direction sets the overall direction of the paragraph. This
should not be confused with paragraph alignment. For example: if you type
an English word and then a Hebrew/Arabic word followed by a period, if
the paragraph direction is left to right the English word will be on the left,
the Hebrew/Arabic word will be to the right of that, while the period will be
all the way on the right. If the paragraph direction is right to left, the direc-
tion will be reversed with the English word on the right, the RtL word to
the left of that, with the period all the way on the left. If there is not a mix
of directions within the paragraph (i.e. all English text), the only effect of
paragraph direction will be on the punctuation at the end and the position

of drop caps/numbering/bullets.

Here are some examples of left aligned left-to-right paragraphs:
. Abulleted paragraph.

“nay” is “Hebrew”.

“au,e1l” is “Arabic”.

Here’s a few left aligned right-to-left paragraphs:

. A bulleted paragraph.

“Mv “mp72y “Hebrew”.

“ 3653 “ausy sl “Arabic”,
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Paragraph Numbering Formats
Besides the standard Roman Numbering Formats for numbered lists, World

Tools includes six ME numbering formats as well as eleven CJK formats.

Paragraph Justification Options

There are three different paragraph justification options available. These are
all applicable when the text is set to “justified”. The “Standard” setting sim-
ply adds space to justify text. The “Arabic” option will use kashidas to take
up space if kashidas are enabled. The “Naskh” option will use naskh justifi-
cation. If an OpenType font has justification alternates (jalt) programmed
into the font and “Naskh” is selected, these alternates will be used to justify
the text. The algorithm used is unpredictable. The justification alternates

will work in any language.

World Tools Panel

iy BIE
L_—i Adobe Paragraph Composer

| |q1-| [; Standard

— b/

Character: Diacritics:
|

[(®A | EAd| A4 | L

[]2 Default |

L o
[+ Kashidas | il

[ fepIL




Style Settings

To access the World Tools Middle Eastern options panel, select Window >
World Tools > World Tools (ME). The panel offers access to most of the
right-to-left features enabled by World Tools. The top section offers toggles
for Document Direction, Story Direction, and Table Direction. The next
section offers control of paragraph attributes such as the composer, Para-
graph Direction and Arabic justification options. The bottom section offers
controls for character settings including direction, number formats and

kashidas. Additionally, there is precise control over diacritic positioning.

Style Settings

Paragraph Style Options

General Style Name: Main Text
Basic Character Formats Locatian: Text Styles
Advanced Character Formars World-Tools Options
Indents and Spacing Paragraph
Tabs
Paragraph Rules Direction: | Left to Ri... B: Justification: | Standard B:
Keep Options
Hyphenation Character Diacritics
Justification . . L .
) Direction: | Default B: Diacritic Position: | OpenType B:
Span Columns
Drop Caps and Nested Styles Digits: | Default B: Adjustments: Vartical: =0
GREP Style . . =
) Kashidas: | On o Horizontal: =0
Bullets and Numbering
Character Colar
OpenType Features OpenType
Underline Cyptions [ Justification Alternate [ Mark Positioning _| Overlap Swash
Strikethrough Options - = =
World-Toals Options |_ Stylistic Alternate |_| Historical Forms __| Roman Italics

[ Stretched Alternate ELocaIized Forms

| Preview ( Cancel ) E—ﬁK—}
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World Tools style settings are set in the standard style dialogs. Shown above
is the paragraph style options. Almost all the World-Ready options are set
using the “World-Tools Options” section. This includes, direction, justifica-
tion, character attributes, and OpenType attributes. The one exception is
the composer options which are added to the composer drop-down in the
“Justification” section as show below:

Adobe World-Ready Single-line Composer
(11117 v Adobe World-Ready Paragraph Composer

Single Word Justification-

Adobe Japanese Single-line Composer
Adobe Japanese Paragraph Composer
Adobe Paragraph Composer
Adobe Single-line Composer

I

The character style dialog is similar, but without the paragraph level attri-

butes:
Character Style Options
General Style Name: Header
Basic Character Formats Location:
Advanced Character Formars World-Tools Options

Character Color
Character Diacritics
OpenType Features

Underline Options Direction: B: Diacritic Position: B:
Strikethrough Options

World-Tools Options Digits: B: Adjustments: Vertical: =
Kashidas: B: Horizontal: =

OpenType

[=] Justification Alternate [=] Mark Positioning [=] Overlap Swash
[=] Stylistic Alternate [=] Historical Forms [=] Roman Italics
[=] Stretched Alternate  [=] Localized Forms

[ Preview (" Cancel ) E oK 3
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Find/Change Options
All World Tools options can be selected in both the find and change dialogs

as well:

Find Format Settings

Style Options. World-Tools Options
Basic Character Formats  —
Advanced Character Formats. L - . . -
Ind Direction: | Right to... 5. Justification: B.
ndents and Spacing
Keep Optians Character Diacritics
$pan Columns A = . n
Direction: | q. Diacritic Position: | B.
Bullets and Numbering - -
Character Color Digits:[ Q: Adjustments: Vertical: =
OpenType Feaures. Kashidas: | B Horizontal: =
Underline Options
Strikethrough Options OBST VRS
Conditions [=] Justification Alternate [=] Mark Positioning [=] Overlap Swash
o eTos s ontons [=] Stylistic Alternate [=] Historical Forms [=] Roman Italics
Drap Caps and Other )
[=] Stretched Alternate  [=] Localized Forms
( Cancel )
——

Other Options

Table Direction

The direction of a table determines whether columns start on the left or
right. The table direction is set by selecting InTools > World Tools > Ta-
ble Direction > (Left To Right / Right To Left). Table direction cannot be
set in table styles. The direction must be set manually on an individual basis.

The table direction can also be set in the World Tools panel (see page 20).

Story Direction

The story direction controls whether columns of text in multi-column
frames flow from the right-to-left or left-to-right. The story direction is indi-
cated by the position of the in-ports and out-ports of text frames. The story
direction can be switched at any time by selecting InTools > World Tools
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- Story Direction > Left to Right/Right to Left Story. The story direction
can also be set in the World Tools panel see page 20 for more information.

Footnote Numbering Options
Besides the standard Roman footnote numbering formats, World Tools in-
cludes four ME numbering formats as well as two CJK formats. This setting

is a document-wide setting, and is applied to the current document.

Chapter Numbering Formats
The Chapter Numbering format is also a document-wide setting. World

Tools includes six ME formats and eleven CJK formats.

Page Numbering Formats

The page numbering format is the format that the numbers take when using
automatic page numbers. Besides for the standard Roman number formats,
World Tools enables the use of four ME formats. The page numbering format

is applied to the section of the current active page.

World-Ready Composer

World Tools adds two new menu items to the Control Panel and Paragraph
Panel drop-down menus. Besides the standard Single-line and Paragraph
Composers, you can select the World-Ready variants of these composers.
Usually, there’s no reason you'd want to use the regular composers over the
World-Ready ones. The World-Ready composer is a super-set of the regular
composer. However if you encounter a bug which is specific to the World-
Ready Composer, switching to the regular composer would be a work-
around the bug (although that would preclude working with ME text.) Also,

if you are using the CJK versions of InDesign, you might want to select the
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Japanese Composer instead. The World-Ready Composer is a parallel com-

poser, and does not support the Japanese aspects of the Japanese Composer.

Additional Options

Apply Hebrew Character Style

A “writing script” is the set of characters used by the computer to compose
text. Each writing script uses a unique set of characters. Each scriptis unique,
but a script can include more than one language. For example, the Hebrew
script is used by Hebrew and Yiddish. The Latin script is used by English,
Spanish, French, and many others. The “Apply Style” functions recognize

characters based on their script, and apply character styles accordingly.

“Apply Hebrew Style” creates a Hebrew Character Style for Hebrew text.
This function should be used when the main paragraph text is in a language
other than Hebrew, and the Hebrew text needs its own formatting. It identi-
fies any text belonging to the Hebrew writing script, and takes into consid-
eration all Hebrew letters, nikud (vowel marks), and taamei hamikra (cantil-
lation marks). Additionally, it makes all single and double quotes “dumb’,
and applies the style to punctuation within Hebrew text. For example the
statement: This is [ayn “Tixn” 190! becomes: This is Payn “Tixn” 100! In this
example the Hebrew style is styled with Fontbit David at a reduced size, the
quotes within the Hebrew statement had the Hebrew style applied to it and
were straightened. The exclamation point immediately after the Hebrew text
retains its regular formatting. The character style should be set before run-

ning this command.
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Apply Style To Hebrew Characters:

Source Paragraph Style: = Any 3] Ei)
Character Style to Apply: | [None] =2 ] (__Cancel )
Apply To: ) Document

() Story
() Selection

The above dialog box shows the options for applying the style. In the “Source
Paragraph Style” drop down list you can either select “Any” or a specific
Paragraph Style in your document. Choosing “Any” will apply the character
style to any Hebrew text in all the paragraphs of the specified range. Choos-
ing a specific style will limit the application of the style to text styled by that
specific Paragraph Style. Use the “Character Style to Apply” drop down list
to select the Character Style to apply.

The second section in the dialog allows you to select the text range. The op-
tions are context sensitive. If there is nothing selected in the document, the
only selectable range will be the document. If there is a story or part thereof
selected in the document, the “story” radio button will appear. If there are
at least two characters selected, the “Selection” radio button will appear as

well. Selections can be either text or text frames.

Apply Latin Character Style
This option is similar to “Apply Hebrew Character Style”. It styles text be-
longing to the Latin script within a paragraph whose main language uses a

different writing script.
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Apply Style To Latin Characters:

Use Current Find Settings Instead [ ﬁ
Source Paragraph Style: = Any | :] ([ Cancel )
Character Style to Apply: ' [None] =5

Apply To Numbers 8

Apply To: @ Document
() Story
() Selection

The above dialog box shows the options for applying this style. Select “Use
Current Find Settings Instead” to search by criteria such as color, character
style, etc. The last find settings used in the application find and replace dia-
log will be used to find the text. Please note: If the “Use Current Find Settings”
is checked, the selection of the paragraph style is ignored. Whether or not this
box is checked the “Character Style To Apply” must be selected. If “Apply
To Numbers” is selected, numbers within the Latin text will be styled with

the selected character style.

The second section in the dialog allows you to select the text range. The op-
tions are context sensitive. If there is nothing selected in the document, the
only selectable range will be the document. If there is a story or part thereof
selected in the document, the “story” radio button will appear. If there are
at least two characters selected, the “Selection” radio button will appear as

well. Selections can be either text or text frames.

Straighten Quotes
Hebrew and some other languages do not use curly quotes. Very often, curly
quotes can creep into Hebrew text unintentionally. Straighten Quotes was

created to deal with this issue.
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Straighten Quotes based on Style

Character Style to Change: = Any -5 ] ﬁ

Fa

Paragraph Style to Change: = Any B Cancel )

Apply To: @ Document
() Story
(") Selection

The options in the above dialog box are self-explanatory. Select a character
style, a paragraph style, both, or neither. You can also select the text range as

in to the “Apply Character Style” dialogs.

Switch Story Direction

Story direction in InDesign ME version is determined by text tool used to
draw the text frame containing the story. If the ME type tool is used, the
story direction will be right-to-left. If the regular type tool is used, the story
direction will be left-to-right. The importance of story direction is primarily
in the direction of text flow in multi-column text frames. The story direction

is set for the story as a whole, and not on a frame by frame basis.

Without this plug-in, InDesign ME allows story direction to be changed af-
terwards by selecting a different story direction in the Story Palette / Panel.
It is a very inconvenient way to switch story direction, since the only other
function of the Story Palette / Panel is the rarely accessed Optical Margin
Setting. The “Switch Story Direction” option provides a convenient way to
change the story direction. Since the command is a menu item, it allows you

to create a keyboard shortcut make changing story direction even easier.
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Number by Spread
This utility offers the option to increase page numbering once per spread
instead of once per page. This is useful when both pages in a spread need to

show the same page number.

Spread Numbering

Starting Page: | 1 ) ook )
Ending Page: 7 I:] (_ Cancel )

By default, the starting page will be the first page in the document, and the
ending page will be the last. These numbers can be set to any page in the

document, thereby giving spread numbering to only part of the document.

Undoing Spread Numbering
Spread numbering can be undone as well. The numbers in the drop-down

list will be the current page numbers — 1,1,2,2, and so on.

Addendum

What is “APID ToolAssistant”?

Classically, there are only two ways to automate InDesign. One way is by
scripting. Scripts are a series of commands written in one of the three sup-
ported scripting languages — AppleScript for the Macintosh, Visual Basic
for Windows, or ExtendScript for both platforms. ExtendScript is Adobe’s
version of Javascript. For scripts to run, they must be placed in the applica-
tion script folder and explicitly run. For automation to be truly automatic,
it requires “event processing”. This means that certain events trigger specific

processes to take place. There is limited event-triggered scripting available
in CS3.
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To achieve true integration, plug-ins must be programmed using C++. De-
veloping c++ plug-ins is a very involved, and lengthy process. APID ToolAs-
sistant is a plug-in which allows very fine grained event processing using Ex-
tendScript. It allows for creation of advanced plug-ins in a fraction of the
time required when programming using c++. It also aids in the creation of

hybrid plug-ins which mix ExtendScript and c++ for maximum efficiency.

Without the APID ToolAssistant, it would not have been possible to cre-
ate the collection of plug-ins we offer in the same amount of development
time. This increased programming efficiency means more functionality for

the end user and lower prices.

Additionally, APID ToolAssistant offers the ability to attach scripts to spe-
cific objects. These attached scripts can be run automatically when triggered
by specific events. Anyone who has a licensed version of the APID ToolAs-
sistant plug-in installed can create and use these attached scripts. There
are also additional scripting properties and methods which are usable by

scripters.

For more information see Rorohiko’s web site at www.rorohiko.com.
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License Agreement
Please read the following document carefully!

This is a legal agreement (the Agreement) between you and Print Israel LLC (In-
Tools), the developer of the In-Tools software. This Agreement pertains to your use of
the In-Tools software and documentation which are provided to you by In-Tools (col-
lectively, the Software). By copying, installing, or otherwise using the Software, you
accept all the terms and provisions of the Agreement.

Terms of Use
The provisions of the In-Tools Privacy Policy are incorporated herein and made a part

hereof.

License

This Agreement grants you a personal, non-exclusive, non-transferable, non-sublicens-
able right to use one copy of the Software for use on a single computer and/or worksta-
tion for each license that you purchase. You may try the Software before purchasing a
license, for the specified amount of time in the materials accompanying the Software.
YOU UNDERSTAND AND AGREE THAT BY USING THE TRIAL SOFTWARE,
AFTER THE AMOUNT OF TIME YOU MAY NOT BE ABLE TO CONTINUE
TO USE THE SOFTWARE UNLESS YOU PURCHASE A LICENSE.

In-Tools reserves all rights in the Software not expressly granted herein, including

without limitation ownership and proprietary rights.

License Restrictions
You may not reverse engineer, decompile or disassemble the Software. The restrictions
contained herein apply equally to any updates that may be provided to you by In-Tools.

Intellectual Property Rights and Third Party Materials

All service marks, logos, trade names, trade dress, and trademarks of In-Tools (col-
lectively Marks) are the exclusive property of In-Tools and nothing in this Agreement
shall grant you the license to use such Marks. All intellectual property rights in the


http://in-tools.com/privacy.html

License Agreement

Software are owned exclusively by In-Tools and are protected by United States of
America copyright laws and international copyright treaty provisions. Any violation of
the terms set forth herein is expressly prohibited by law and may result in severe civil

and criminal penalties.

Disclaimer of Warranties

ALL SOFTWARE PROVIDED BY IN-TOOLS ARE PROVIDED AS IS. IN-TOOLS
AND ITS AGENTS, PARTNERS, OR EMPLOYEES MAKE NO REPRESENTA-
TION OR WARRANTY TO YOU OR ANY OTHER PERSON OR ENTITY,
WHETHER EXPRESS, IMPLIED, OR STATUTORY, AS TO THE DESCRIP-
TION, QUALITY, TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
COMPLETENESS, OR FITNESS FOR A PARTICULAR USE OR PURPOSE AS
TO THE SOFTWARE PROVIDED TO YOU, OR AS TO ANY OTHER MATTER,
ALL SUCH WARRANTIES HEREBY BEING EXPRESSLY EXCLUDED AND
DISCLAIMED.

NEITHER IN-TOOLS NOR ANY OF ITS AGENTS, PARTNERS, OR EMPLOY-
EES WARRANTS THAT THE SOFTWARE OR SERVICES ARE ERROR FREE
OR WILL OPERATE WITHOUT CAUSING LOSS OR INTERRUPTION YOUR
COMPUTER USAGE OR DATA. YOU ASSUME TOTAL RESPONSIBILITY
AND RISK FOR YOUR USE OF THE SOFTWARE.

Limitation of Liability

IN NO EVENT SHALL IN-TOOLS, ITS AFFILIATES, SUBSIDIARIES, PAR-
ENT COMPANIES, AGENTS, NETWORK SERVICE PROVIDERS, PARTNERS,
OR EMPLOYEES BE LIABLE TO YOU OR ANY THIRD PARTY IN ANY RE-
SPECT FOR ANY COSTS OR DAMAGES ARISING EITHER DIRECTLY OR
INDIRECTLY FROM THE USE OF IN-TOOLS SOFTWARE INCLUDING
WITHOUT LIMITATION ANY ACTUAL, INCIDENTAL, CONSEQUENTIAL,
EXEMPLARY, PUNITIVE, RELIANCE OR SPECIAL DAMAGES, OR FOR ANY
LOSS OF REVENUE, PROFITS, USE, DATA, GOODWILL OR BUSINESS OP-
PORTUNITIES OF ANY KIND ORNATURE WHATSOEVER, ARISING IN ANY
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MANNER FROM ANY CAUSE OF ACTION OR CLAIM RELATING TO THIS
AGREEMENT, TO THE SERVICES PROVIDED BY IN-TOOLS ORTO THE USE
OF THE SOFTWARE. THIS LIMITATION OF LIABILITY APPLIES EQUALLY
TO ANY THIRD PARTIES WITH WHOM IN-TOOLS ENTERS INTO A BIND-
ING AGREEMENT TO MARKET, DISPLAY AND/OR DISTRIBUTE THE
SOFTWARE TO END USERS AND SUCH THIRD PARTIES SHALL NOT BE LI-
ABLE TO YOU ORANY OTHER THIRD PARTY FOR ANY OF THE DAMAGES
SET FORTH ABOVE.

Export Control Laws.

You agree to comply with all laws, rules and regulations applicable to the export of the
Software. Specifically, you shall not export, re-export or transship the Software, or the
direct product thereof, in violation of any United States laws and regulations which
may from time to time be applicable. None of the Software or underlying information
or technology may be downloaded or otherwise exported or re-exported (i) into, or
to a national or resident of, Cuba, Iran, Iraq, Libya, North Korea, Sudan, Syria or any
other country to which the U.S. has embargoed goods; or (ii) to anyone on the U.S.
Treasury Departmentss list of Specially Designated Nationals or the U.S. Commerce
Department>s Table of Denial Order. By downloading or using the Software, you are
agreeing to the foregoing and you are representing and warranting that you are not
located in, under the control of, or a national or resident of any such country or on any

such list.

Jurisdiction and Other Provisions

This Agreement and the relationship between In-Tools and you shall be governed in
accordance with the laws of the State of New York. Any dispute between you and In-
Tools regarding this Agreement will be subject to the exclusive jurisdiction of the state
and federal courts in the State of New York. You agree to submit to exclusive jurisdic-
tion in the State of New York, and you expressly waive all defenses to jurisdiction.

This Agreement is the entire agreement between you and In-Tools relating to your use

of the Software and supersedes any other communications or advertising with respect
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to the Software. If any provision of this Agreement is held invalid, the remainder of
this Agreement will continue in full force and effect. In-Tools failure to insist upon or
enforce strict performance of any provision of this Agreement shall not be construed
as a waiver of any provision or right. Neither the course of conduct between the par-
ties nor trade practice shall act to modify any provision of this Agreement. In-Tools
may assign its rights and duties under this Agreement to any party at any time without

notice to you.

Modifications of Agreement

In-Tools may modify this Agreement at any time without providing notice to you.
Such modification will be made by posting a revised agreement on its web site and
such modification shall be deemed effective immediately upon posting of the modified
Agreement. Your continued access or use of the Software or Services shall be deemed
your acceptance of the modified Agreement. You agree to check our web site periodi-
cally to review such modifications.

Termination or Modifications of Software

You may terminate this Agreement at any time. The In-Tools may immediately termi-
nate the Agreement if you breach any representation, warranty, agreement or obliga-
tion contained or referred to in the Agreement. Upon termination, you must dispose of
the Software and all copies or versions of the Software by destroying the Software. In-
Tools reserves the right to modify the Software at any time without providing notice to
you. In-Tools right to modify the Software applies to all or any aspect of the Software.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT AND
UNDERSTAND IT AND THAT, BY USING THE SOFTWARE, WEB SITE, YOU
AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.




